Downloading and Installing DevC++
What is DevC++7?

DevC++ is a full-featured integrated development environment (IDE) that uses the MinGW
version of C++. An IDE is a program that allows you to edit, compile, and debug your C++
programs without using the command-line.

DevC++ comes with everything you need to compile and link both console-mode and GUI
programs that will run on Windows 95/98/NT/2K/XP; your programs will not run on Windows
3.1 or on plain DOS machines however. You don't need to download and install anything else.

The rest of this page will walk you through the steps necessary to download, install, and run your
C++ programs using DevC++ and the included version of the MinGW C++ compiler.

What is MinGW?

MinGW ("Minimalistic GNU for Windows") is a command-line C/C++ compiler and utilities,
based on the GNU GCC project. It compiles and links code to be run on Win32 platforms
(Win95 through XP). Unlike some other versions of GCC, MinGW uses the Microsoft runtime
libraries, distributed with the Windows operating system. Since these runtime libraries are not
distributed using GNU's General Public License (GPL), you do not have to distribute your source
code with your programs unless, of course, you use a GPL library in your programs.

Step One: Download DevC++
Click on the following link:

http://www.bloodshed.net/dev/devcpp.html

At the bottom of the page, select to download: Dev-C++ 5.0 beta 9.2 (4.9.9.2) (9.0 MB)
with Mingw/GCC 3.4.2. This will take you to a download page. Save the file, devcpp-
4.9.9.2_setup, to your computer.

The downloaded file is about 9 MB; on a DSL/Cable connection it takes under 5 minutes to
download. On a dial-up connection, though, downloading may take a while. In that case, you
may want to copy the installation files from the computer lab, then transfer it to a USB thumb-
drive.

Step Two: Install DevC++

Locate the file devcpp-4.9.9.2_setup on your computer.



Dev-C++ 5 beta 9 release [4.9.9.2)

You will get a window indicate the start of the install followed by:

Installer Language [Z|
- Please select a language,
(*7
T |
[ Ik l [ Cancel ]

Select “OK” for English.

# Dev-C++ 5 beta 9 release (4.9.9.2)

License Agreement -
Please review the license terms before instaling Dev-C++ 5 beta 2 release (4,9,9.2), (.;J

Press Page Down to see the rest of the agreement.

Bloodshed Dev-C++ is distributed under the GRU General Public License,
Be sure ko read it before using Dev-C++.,

8]

GMNI GEMERAL PUBLIC LICEMSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

675 Mass Ave, Cambridge, Ma 02139, USA
Evervone is permitted to copy and distribute wverbatim copies
af this license document, but changing it is nok allowed.,

| &

If wou accept the terms of the agreement, click I Agree to continue. ou musk accept the
agreement to inskall Dev-C++ 5 beka 9 release (4,9.9,2).

[ I Agree l [ Zancel

Select “I Agree”



# Dev-C++ 5 beta 9 release {4.9.9.2)

Choose Components -
hoose which features of Dew-C++ 5 beta 9 release (4.9.9, 23 vou want to inskall, (*j

Choose components

Select the bype of install: | - |

O, select the u:-ptiu:_unal Dev-C++ program & Description
;_;Insr'l:'nl;:ii::nents woll wish ko Example files =
' Help files
Icon files
Mlingw compiler sy
Language files —
Aszociate C and C
Space required: 59,ZMB IEreaFe s_hu:.ur!:c.uts ! bl
% | >
< Back ” Mext = l [ Cancel

Select “Next”.

# Dev-C++ 5 beta 9 release (4.9.9.2) A=l

Choosze Install Location ~
Choose the Folder in which toinskall Dev-C++ 5 beta 9 release (4.9.9.2), (

Select the directary ko install Dev-C++ ko

Destination Folder

| Browse, .,

Space required: 59, 2M6
Space available: 7. 1GE

< Back ” Install l [ Zancel

Select “Install”.



® Dev-C++ 5 beta 9 release {4.9.9.2) o)X

Completing the Dey-C++ b beta 9
release {4.9.9.2) Setup Wizard

Dew-C++ 5 beta 9 release (4.9.9.2) has been installed on
wour compuber,

Click. Finish ko close this wizard,

[*]Run Dev-C++ 5 beta 2 release (4,9,9,2%

[ Einish l [ Cancel

DevC++ 5 beta 9 release (4.9.9.2) should be installed.

Step Three: Configuring the IDE

A. Configuring the IDE for the first time

You will need to configure the IDE the first time you run DevC++. You may also need to
configure it the first time you run it in the computer lab also.

Beta wersion Motice E|

This is a beta version of Dev-C++.Please report bugs at hkkpsffblondshed. netfbugs. We provide updates often, so be sure to
check Far them in Toals menu, Check for Updates/Packages.,

Your config files will be stored in Ci\Documents and SettingstDavid Ekker\application DataiDev-Cpp
Otherwise, vou can pass the Following parameter to Dev-C++ ¢ -c ciyconfig_file_directaory

Select “OK”.



Dewv-C++ first time configuration

File Edit Search Wiew 1hisis the first time you have launched Dew-C++. You
= = = = may canfigure the startbup settings now, or later change

|:| E them from the Environment options in the Toolz menu.

:::: El E ) Qﬁj Select your language :

Chinese ”
main. cpp | Chinese [T
Croatian
#include <uv | |Czech [Eelting
Dranish

% Declare Diutch (Mederands |

LRESULT CAI | =

Select your Dev-C++ theme ;
S% 0 Make t}

char szClas |New Laoak ﬂ
[ UszexP Theme

3 Mext |

int WINAFI

I recommend you use the default and select “Next”.

Dew-C++ first time configuration

File Edit Search ‘Wiew Dev-Ca+ canretieve information from headers files, to
— — = help you find functions, clazses and vanables

|:| E prototypes eazily, through a clazs browser and a code

- completion list,
rrO0@ &

main. cpp |

Althaugh this feature iz useful, it requirez more
CPU power and memory, and may not be zuitable
for all developers. Do wou want bo uge it 7 You
zah enable ar dizable it later in Editor Options,
Clazs Browser.

finclude <

A% Declare
LEEZULT CAI

f* “Yeg, | want to uze this feature
A% Make &£}
char szCla:s

(" Mo, | prefer to uze Dew-C++ without it

int WINAFPI

B Meut

For most users this is not a problem, select “Next”.



Dewv-C++ first time configuration

File Edit Search Yiew Toudecided touse the code completion feature. To
= = = = optimize this process, it is recommended to create a

H |:| E cache of the standard headers files.

mE i
= s El E Qﬁ Do you want to create the code completion cache
main. cpp | now? This can take several minutes. IF iz pogsible o
create thiz cache later in Editor Options, Class
#include <tv  Browsing, Completion.

A% Declare

LEESULT CAL f* ‘Y'ez, create the cache now

" Mo, do not create the cache

/% Make tl [ Use thiz directony instead of the standard one:

char szCla:s
| =3

int WINAFI

3 Mext

Select “Next”. After about 2 minutes, you should get:

Dewv-C++ finst time configuration

Fle Edit Search Yiew C['&v-C++hasbeen configured successhully, you may

now click 0K to proceed ta itz loading.
[ E &

If you need help uzing Dew-C++, please refer to the
{ FF 0O B L[ ij Diev-C++ help file in the Help menu. You will also find
- there a FAQ [which is wery important to read in casze
rmain. cpp | wal have a prablem] and a C tutarial.

#include <v  You can also download packages (ke lbrares or
toolz] to uze with Dew-C++, and upgrade to the latest
werzion by using ‘Weblpdate, which vou will find in

4% Declart Taol menu, Check for Updates/Packages.

LERESULT CAIL

A% Make &}
char szCla:s

int WINAPI

" 0K

Select “OK”. DecC++ should start and you will get a “Tip of the day’ window.



Tip of the day [z

@ Did you know... Previous Tip

.you zhoulde't dizable these tips?

The tipz presented here will give pou
undocumented infarmation not found angwhers
elze.

[f you dizable them and want ta view them at a
later time, select "Help # Tip of the day"...

Cloze

Read them if you like, when done, select “Close” and you should get the following window:

[ Don't dizplay tips at startup

™ Dey.C++ 4.9.9.2 FEX

File Edt Search Wew Project Execute Debug Tools CWS  window Help

94 O MY Y IEEIL
- v ? D New IJE Inzert ﬁToggle EI Goto
| =l =

Project l Elasses] Debug]

EE Compilerl @ Hesourcesl dﬂ] Cornpile Log1 Qf Debug] @ Find Resultz

Ready.

B. Configure the Environment Options

Environment options make it easier for using the compiler. The Environment Options are
located under the Tools menu:



™ Dev-C++ 4.9.9.2
File Edit Search ‘iew Project Execute Debug BEllEN CwS  Window  Help

D Campiler Options

= 8: Environment Options

? D New 2 Editor Options

| j| E Configure Sharkcuts
Project lCIassesl Debugl T configure Toals

<Hb Check For UpdatesiPackages. ..

Package Manager

Change to the Files & Dir tab, and then click the button to the right of User’s Default Directory
text field. (You can’t type directly in the field.)

Enyironment Options [5__<|

| Files & Di.. |

Alternate Configuration File

[ Usze this alternate configuration fils

IJzer's Default Directory
|E:'\D ev-Cpph

Templates Directory

=

|Templates'\

Locate the folder where you want to store your files. | like storing them on my c: drive in a
folder called work. It makes it easier when working on the individual source files we will be
using at the beginning of the class:

Environment Options

| Files & Dir..

Alternate Configuration File

[ Usze this alternate configuration fils

IJzer's Default Directon
|E:'\wu:-rk'x 2




C. Configure the Editor Options

™ Dev-C++ 4.9.9.2

Fille Edit Search Wiews Project Execute Debug RSN WS Window  Help
D Compiler Opkions
o= . .
= Enwvironment Oplions
@ [=L*]
e D New Editor Options
| j| E Configure Shortcuts

Froject lCIassesl Debugl T configure Tools

< Check For Updates/Packages...

Package Manager

Feel free to experiment and select whichever options you like. The one | want is to have line
numbers displayed. To do this, select the Display tab, and click the Line Numbers checkbox, as
shown here:

Editor, Options [5_(|

| Digplay |

E ditar Font:
Font Size

|Eu:uurier Mew ﬂ |'| 1] ﬂ

Editor Font

[3Litker
v “isible ' d
[ Auto Size tart at Zero

v Usze Cuztom Font [ Show Leading Zeros
Font Size Width

|Termninal EIRRE | I

Gutter Font

s/ Ok | x Canecel | ? Help




D. Configure the Compiler Options

™ Dey-C++ 4.9.9.2
File Edit 3Search View Project

Execute Debug NI WS Window  Help

L s
o &= Environment Options
? D B Eﬁ Editor Options
| ﬂ' E Configure Shortcuts
Froject l Elassesl Debugl T Configure Tools

985 Check for Updates/Packages. ..

Package Manager

On the Compiler tab, add the following switches when calling the compiler:
-ansi -pedantic -Wall

Note that the W in Wall is capitalized, but everything else is lowercase. Here's what this tab
should look like:

Compiler Options

| Compiler |

Compiler set to configure:

| Default cormpiler ﬂ ﬂmﬂ

v Add the following commands when calling compiler:

-ansi -pedantic wall

[ Add theze commands to the linker command line

On the Settings tab, choose Code Generation, and change Enable exception handling to Yes, as

shown here:
Compiler, Options E'
| Settings |
C compiler Enable exception handling ez ﬂ
C++ compiler _ Ilze zame size for double and float Mo
Code Generation 5y eutra commentary information in the generated . No
E,Die profiling Generate ingtructions for the following machine
irker L .
. Enable uze of proceszor gpecific built-in functions
+-- Optimization




While still on the Settings tab, choose Linker and change Generate debugging information to
Yes as shown here:

Compiler Options E'
| Settings |

C compiler Link an Objective C program Mo

L+ compiler . Generate debugging information Tes ﬂ

Code Eenf”at":'” Do niot use standard systemn statup files or ibrates Mo

E,Die profiling Do not create a console window Mo

irker )
Strip executable Mo

+-- Optimization

Step 4. Create source file, compile and run your first
program.

A. Open a new Source File
Using the File Menu,

* Dev-C++ 4.9.9.2
M Edit Search  Wiew Project Execute Debug  Tools CWS window  Help

(] T
Project. ..
Open Project o File,.,  Chrl+O et ﬁTnggle |!] Goto

r & Resource File

Or simply by clicking on new Source File button or pressing Ctrl+N:



el |

™ Dev-C++ 4.9.9.2

File Edit /né?i:h\ Wiews Project  Execute Debug Tools

& &l ), L

rdtce File (Ckel4HM) E'g') D Mew I:E |rzert

Froject l Elassesl Del:nug]

Carefully type in the following program into the resulting window, be careful, it is case
sensitive!

™ Dev-C++ 4.9.9.2

File Edit Search Miew Project Execute Debug Tools OS5 Window  Help
BREE o [EYEgeQE=
B2 O B 5§ 7 [INew dl]lnzent 48] Toogle (W] Goto
Project ] Classes | Debug| [] Untited |

1 #include <iostresm:

using namespace =td;

int maini)
{

cout << "Hello World!™:

= E w0 G0 =] TR B LD B

-

Make sure you have everything exactly as given.



B. Saving your source file
Once done, go ahead and save the file:

"™ Dev-C++ 4.9.9.2
File Edit

= o Yy sQEs
- {Ctrl:S]l |:| Mew @Insert ﬁTDggle m Go

//T |

Project l |:|533.33] Del:uug] [*] Untitled? l

1 #include <ioatream:
2

3 using namespace 3td;

4

Project Execute Debug  Tools CWS  Window  Help

When saving files, make sure you follow the following rules:
1. File names should start with a letter, it is not case sensitive!
2. File names may include letters, numbers, or under_scores, but the first character must be
a letter!
3. File names should be descriptive. At the beginning of the class, there is not much
problem, but as we get close to the end of class, it will be more important.



Save File @

Save in: |l.ﬂ wiork, j £ EE-
Ty ICCHOZ [CMiscellaneous
33 ICHCHD3 ICiMew Folder
MyRecent |[=)cHO4 e hello

Documents [=)HOS
@' ) CHOG
IChcHO7

Dezktop () CHOR
. ICCHO9

U ICcHI0
IChcH1L

My Documents ycHIZ

e ICHCH1E

3{3 IChcH14

by Computer (CiData
ICDemos

My Metwark  File name: hellowarld -] Save |
Places
Save as ype: |E++ gource files [* opp.™ oo cwe™ o++." op] j Cancel

C. Compiling your source file
For simple programs, only one file is required and you can compile your source file using the

compile button:

™ DevC++ 4,9.9.2

File Edit Search Miew Projectk Execute Debug Tools Cws indow  Help
B Ao [CYeQgeQE=

c? DNEW @Insert ﬁTnggle |!]I3n:ut|:|

Compt (Ctri+F5) | = E

Fraject ] Elasaesl Del:uugl helloworld. cpp l

‘ ‘ 1 #include <iostream:>
2

If you compiled successfully, you should get the following window:



Compile Progress
Progress | Log

Compiler: | Default compiler

Statuz: | Done.

File:

Errors: 0 ‘“Warnings: 1]

You have successfully compiled your first program!

D. Running your program
The compiler took your source code and converted it into a file which will run on your computer.

This téEe of file is called an executable file. Let’s see what it looks like in the c:\work folder:

File Edit Wiew Faworites  Tools  Help

@Back - .‘F j:.l Search || Folders v

Address (I Crwork
| = f- Mame -~ Size Tvpe

File and Folder Tasks = [)Data File Folder
o File Fald

L-j Make a new folder I:I '_Em':'s !E S

; _ _ I Miscellaneous File Folder

L2 E'-.I;IEIL:Sh this Folder to the () Mew Folder File Falder

£ share this folder lEIl.I hellawiorld 1KE C4+ Source File
rﬂhelluwnrld S66 KB Application

There are two files named “helloworld”. The first is the file you created by typing in code and
saving. The second is the executable file created by the computer. This is an actual computer
program. If you double click on it, a window quickly appears and disappears. This is MS
Windows “Command Prompt” window. The program opens a Command Prompt window, runs
your program, and then immediately closes the window before you can examine the output.

You have two ways of addressing this situation:
1. Adding a system(“pause”) command — recommended option
2. Using the Command Prompt window — not covered here



1. Adding a system (“pause”) command

Carefully modify the source file to add a pause in the program:
#include <iostream>
using namespace std;

int main()

{

cout << "Hello World!" << endl;
system(*'pause’™);
}

Now compile and run the program. You should get the following window:

e+ C:worklhelloworld. exe

Hello World?
Press any key to continue . . .

Press any key to continue.



Printing from the output window

e Right-click in the output window and pick Select All
e C:\Dev-Cpp\Hello World\Hello World.exe

Hello World?
Press any key to continue . . .

Select 4l
Scroll
Find...

e Press the Enter key to copy the selection to the clipboard.
e Open Notepad (or any word processor) using Start — All Programs — Accessories —

Notepad
e Paste the clipboard contents into clipboard

e Select File — Print within Notepad.
e If you wish to save the output file, use the File — Save option in Notepad.

I Example Output - Notepad

File Edit Format Wiew Help

Hello world! ]
Press any key To continue

Fonts: Recommended font: Courier New

e When you paste the contents of the output window into Notepad, some of your
formatting may seem to change (this is especially noticeable with an output table). This
is because many fonts use different widths for different letters.

e Courier New is a font that uses the same amount of spacing for each letter or symbol
which is nice when columns of numbers are created as in tables.

e After you paste the contents of the output window into Notepad, change the font to
Courier New if you don’t like the appearance of the output.



